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Introduction to Version 6.0 

Introduction 
Canam Software is pleased to announce the availability of Report Composer Version 
6.0 as of September 1, 2004. There are many, many improvements in version 6, but 
perhaps the most dramatic change is the new report designer for plain text and 
graphical reports. The new designer looks dramatically different, and includes 
extensive new features for building sophisticated graphical reports in C, COBOL and 
Java languages. 
 
 All of your existing Report Composer repositories will be automatically converted 
to the version 6.0 schema and to the Jet 4.0 database engine format when you first 
use them. There is no need for a separate conversion utility to convert your version 5 
repositories.  
 
This document has been prepared to introduce you to the new features of Version 
6.0. The following sections will describe the many new features. Report Composer 
Version 6.0 is available as a free upgrade (not including Crystal Reports software) to 
all licensed customers of Report Composer with fully paid maintenance fees.  Please 
contact us or your local distributor to receive your new CD-ROM containing the 
upgrade. Upgrade requests may be made directly via our web site at 
www.canamsoftware.com.   
 

User Manual 
As with the release of previous versions, a printed user manual will not be provided. 
Instead, the full user manual will be shipped as a Microsoft Word document on the 
CD-ROM. Licensed users are free to print or make available to their developers on 
networks or workstations all or part of this document as they see fit. Our online help 
and the manual contents match, they are both generated from the same source 
material. This paperless approach to documentation enables us to keep the materials 
up to date and available via our web site. 
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Customer Communications & Support 
Many of you have recently received our Canam Software e-Newsletter. We will 
continue to publish this e-newsletter periodically. It will contain information about 
the many features and improvements that we continually put into all of our products. 
These e-Newsletters are posted on our web site (www.Canamsoftware.com) for 
future reference.  In addition, levelset history for all currently supported versions of 
Report Composer is available on the Report Composer pages of the web site. 
 
If you have any questions of a general nature, or require technical support, please 
contact us via email at support@canamsoftware.com, or by telephone at 1-905-712-
3840.  
 

Terminology Changes 
There are a few key terminology changes you should be aware of as you continue to 
read this document, and as you work with Report Composer Version 6.  We formerly 
referred to reports designed with Crystal as “GUI” reports – in Version 6 we refer to 
them as “Crystal” reports.  We formerly referred to reports built with the Canam 
report designer as “block mode” reports, and web reports as block mode reports with 
markup. We now refer to them as “Canam” reports, which come in two types: plain 
text or graphical. 
Unless otherwise mentioned in the text, all references to AllFusion Gen apply 
equally to earlier versions of Advantage Gen. 
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Conversion from Previous Versions 

Converting from earlier versions  to 6.0 

Installation 
All of the components, including the runtime components (Canamvu32 and 
Canamcr232) have been upgraded, and modules other than runtime support modules 
have been renamed so as to clearly differentiate them from the v5 versions. The key 
Report Composer components are listed below 
 
RC50.EXE becomes RC60.EXE 
CANAMVU32.EXE retains the same name 
CANAMCR132.EXE is now obsolete – its functions are now part of the generated 
EAB code 
CANAMCR232.EXE retains the same name 
RC50RM.EXE becomes RC60RM.EXE 
RC50UT.EXE is now obsolete – its functions are now part of the main workstation 
tool 
RC50.MDB becomes RC60.MDB 
RC50RP.MDB becomes RC60RP.MDB 
  
In addition, many supporting DLL’s and OCX’s have also changed. Make sure to 
follow the installation provided on the CD. 
 
We recommend that you install Report Composer v6.0 into the same directory as you 
currently have version 5. The installation process will install a new local repository 
(RC60.MDB). The first time Report Composer 6 is executed, if it finds an existing 
local v5 repository (RC50.MDB) in the target directory it will ask you if you want to 
convert it to version 6. The version 6 repository is a JET4 Microsoft Access 
compatible database. Note: Your existing version 5 repository will not be 
affected. 
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If your RC50 database is in a different directory than your application, you can select 
it by clicking on the browse button on the Logon window. You will be able to select 
any local repository from this window, be it version 5 (RC50.MDB) or version 6 
(RC60.MDB) 
The installation process will allow you to repeat the same procedure for Canam's 
Repository Manager software. When you open a version 5 shared repository with 
Repository Manager 6.0, you will be given the option to convert the shared 
repository to Version 6.0 Jet 4.0 database engine format. The conversion process 
creates a new version 6.0 shared repository (RC60RP.MDB) without affecting your 
existing version 5 shared repository (RC50RP.MDB). 
 
Note: Once a repository (local or shared) has been converted to v6.0 format, it 
cannot be used by any Report Composer v5 program. 
 
The version 6.0 installation process will also place DLL’s, OCX’s and some other 
supporting files into your Windows\System or WinNT\System32 directory as 
required. It will not replace a component if a newer version already exists on your 
workstation. 
 

Conversion of Crystal Reports 
With this new version of Report Composer, we no longer distribute any version of 
Crystal Reports as a no-charge part of our product.  We do however sell Crystal 10 
single user copies or site licenses for use with Report Composer at an extra charge.  
You must contact our sales department to make arrangements to get this software 
directly from Canam Software. Alternatively, we will support version 8.5, 9 and 10 
of Crystal Reports that you provide yourself, running as stand-alone licenses. 
 
Our runtime environment will continue to run any existing Crystal 7 reports you may 
have, but you will not be able to perform version control or build new Crystal 7 
reports with Report Composer version 6.  If you need to continue using Crystal 
Reports with Report Composer, there are four alternatives: 

• Continue to maintain these EAB definitions with Report 
Composer 5 and Crystal Reports 7 for Report Composer 

• Redesign these reports using the new Report Composer 6 
Canam graphical reports 

• Purchase Crystal 10 licenses from Canam Software and 
convert your Crystal 7 reports to Crystal 10 

• Use Crystal 8.5, 9, or 10 licenses you have acquired from 
somewhere other than Canam Software and convert your 
Crystal 7 reports to that version 
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Please contact us for further information on Crystal licensing. 
 

 

Runtime Considerations 
You will be able to run Report Composer v5 EAB's on the same workstation as V6.0 
EAB's. There is no need to convert all of your existing EAB’s. Version 5 EAB’s will 
invoke the V5 runtime components or backward compatible version 6 components,  
and version 6.0 EAB’s will invoke the v6.0 runtime components. 
Comment: There will only be one copy of canamvu32 or canamcr232 on the 
machine. The new v6 versions of these components are backwardly to version 5 
EAB’s but the v5 versions of these components are NOT forwardly compatible with 
version 6 EAB’s 
 

Conversion of Web Reports 
Version 5 web reports were implemented using pre-tags and post-tags. In Report 
Composer version 6, the markups have been implemented as properties of each 
report object. Since users are free to modify these tags as they see fit there is no 
algorithmic mechanism by which the pre-tags and post-tags from version 5 can be 
converted to version 6 report object properties. Hence all existing markup strings are 
converted as pre-tags and post-tags for each field. The effect on the appearance of 
the report however, will remain the same.  
It is recommended that users review each of their marked up web reports after the 
conversion and manually convert the pre-tags and post-tags to actual Report 
Composer report object properties. This will ensure the integrity of their report 
design going  forward.  
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New Report Designer 

Report Designer Overview  
The Report Composer version 5 block mode report designer, and the additional web 
report designer, have been combined into a single state-of-the-art report design tool 
with an extensive list of improvements and new capabilities.  The new integrated 
designer has been re-invented from the ground up, eliminating the need to go to a 
second designer tool for the addition of graphical elements to plain text (block mode) 
reports.  The report designer operates in two modes: plain text and graphical.  A 
quick mouse-click switches you back and forth between the two modes, and the 
underlying report objects are the same.  In plain text mode, graphical objects and 
properties are simply not visible, although they are still there as part of the design.  
When you generate code, you choose whether to generate code for the plain text or 
graphical version of the report. 

 
The new designer is completely graphical, and the window is divided into three 
smaller windows: 

• Candidate object tree and report definition tree window on the left 
(switch between them using a tab at the top of the pane) 

• The design window in the middle  
• The property sheet window on the right 

 
These three areas can be resized with the mouse by dragging the vertical bar 
separating them.  The property window can be closed completely, or made to hide 
and automatically re-appear when the mouse hovers over the right edge of the 
window. 
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The new candidate object tree window is used as a toolbox for all sections and 
objects used to design a report.  Each section or object of the reports has properties 
set easily in a property window, similar to the style of Visual Basic.  The report 
designer has complete undo and redo support, making it much easier to use. 
Extensive new support for vertical and horizontal alignment, object sizing and 
automatic spacing has been added. An optional underlying alignment grid, plus 
optional horizontal and vertical rulers, are customizable, along with optional 
alignment bars while moving objects.  A new ability to zoom in and out enables fine 
adjustments to object placement in the design window. 
 
Sections in the design window are separate areas, and show the section name and 
sub-report name they belong to (see figure below). Control break headers and footers 
show the names of breaking attributes, where space permits.  Any section can be 
collapse to hide it from view, using the minus sign in the top left corner of the 
section. Clicking the plus sign in the same place will expand it again. 
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A new tree view, called the report definition tree, shows the report’s sections and 
objects. It allows easy copying, pasting and deleting of one or more objects between 
report sections and even different sub-reports. 
 
Many objects are available to be placed on graphical reports for the web, including 
customizable html tables, boxes and horizontal/vertical lines, checkboxes and radio 
buttons, hyperlinks and images. Images can be set at design time, or a path to the 
image can be provided at runtime from a text attribute in your AllFusion Gen 
application. 
 
Since graphical reports are viewed in a browser, images and literals can have 
hyperlinks, set either at design time or dynamically at runtime from a text attribute in 
your AllFusion Gen application.  Graphical reports rendered in Java (‘web’ reports) 
can also have charts, as well as developer-defined formula fields with an extensive 
scripting language and convenient pre-defined functions. 
 
Extensive graphical formatting properties are available, including background color, 
font (including typeface, point size, strikethrough, underline, bold, italics, and 
overline), borders, border style, color and width. A new format painter tool enables 
you to pick up properties from one object and instantly apply them to another object.  
 

Property Sheet 
Properties for report sections and objects are now viewed and set on a new property 
sheet (see sample below), similar to that found in Microsoft Visual Studio, 
eliminating tedious dialog with the developer.  Properties of objects are easily 
viewed and set at any time.  By default the property sheet is displayed with the 
properties organized into convenient categories, but there is also an option to list 
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them in alphabetic order if desired.   When displayed by category, the details of each 
category can be contracted or expanded if desired. 
 

 
 
When more than one object is selected in the design window, the property sheet will 
be adjusted to show only those properties that are common to all the selected objects.  
Common properties that are editable can then be changed easily for all the selected 
objects at once. 
 
The property sheet can be hidden completely to make more room in the design 
window – redisplay the property sheet by clicking the icon on the toolbar or the 
Properties menu item on the View menu.  You can also set it to hide and appear 
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automatically by setting the AutohidPropertyWindow property to true in the 
workstation defaults property sheet. 
 

Workstation Defaults, Report Definition Defaults Property 
Sheets 
Many defaults for the report designer are stored at the workstation level – too many 
to display in the general Report Composer Options window. A special property sheet 
exists to view and edit them. Also, each report definition has its own defaults at the 
report level. These are initialized from the workstation defaults when a new report 
definition is created.  The report definition property sheet is used to view and edit 
them.  The two special property sheets can be accessed from icons on the toolbar 
(see figure below). 
 

 
 
The workstation property sheet is partially illustrated below. 
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The report definition property sheet is partially illustrated below: 
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Candidate Object Tree 
All the building blocks that are used to design a report are provided together in a tree 
called the candidate object tree (see sample below). From here, sections are dragged 
onto the report design, and attributes from your EAB views are dragged into 
sections. You can also drag special fields, images, lines, boxes, hyperlinks and many 
more design objects and drop them where you want them on the report layout.  
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The tree contains report structure objects at the top, and all the other report objects 
below.  The report structure objects are those that define the structure and sections of 
the report, including sub-reports, report header/footers, page headers/footers, and 
control break header/footers.  These can be added to the report by dragging them 
from the candidate object tree and dropping them on the report design window. For 
section objects, you can drag the header or footer individually, or you can drag both 
at once. For example, to add both a page header and footer at the same time, simply 
drag the page header icon onto the design window.   
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Report structure objects can also be added to the design by double-clicking them in 
the report object tree.  The nodes on the tree will become disabled if the structure is 
already on the report, or in the case of the sub-report node, if the special 
SUBREPORT-CODE attribute is not in the import views of the EAB.  The detail 
section is not represented on the tree because it is always required, and is therefore 
added by default to any report or sub-report, and cannot be removed. 
 
The remaining report objects can be added to the report simply by dragging them 
with the mouse from the tree and dropping them onto the desired report section in the 
design window.  Alternatively, they can also be added from the Edit menu. 
 
 

Report Definition Tree 
There is also another tree, which provides a hierarchical view of the report design.  
This tree gives another convenient view of the complete report design, including the 
main report and each sub-report, showing sections and objects within each one. It 
provides an alternate way to select, copy, move and delete objects from one area of 
the report to another.   
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The objects on the tree and the objects in the design window are linked – selecting an 
object on the tree automatically selects it on the design window, and vice-versa.  
 

Find 
This new feature helps you to quickly find a text string somewhere on the report.  It 
is invoked from the menu or toolbar, and will display the dialog box below. 
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You can enter a text string, and find a single occurrence or all occurrences, on the 
currently displayed sub-report or all sub-reports.  Each occurrence found is selected 
on the report design window and the report definition tree.  Once selected, they can 
be deleted, moved or copied as a group with ease. 
 

Undo/Redo 
The new report designer has an extensive undo and redo facility. The designer 
remembers a deep list of actions, and permits you to sequentially undo, and then 
optionally redo, these actions. 

 

Object Naming 
As each object or section is added, it is given a unique name, based on what type of 
object it is, and a unique number.  You can see the object names on the candidate 
object tree, on the property sheet when the object is selected, and also by hovering 
the mouse over the object in the design window.   The object names are used in the 
formula editor, if formula fields are used in Java graphical reports. 
 
 

Enhanced Edit patterns for Dates, Times, Timestamps, 
Numbers 
 

The edit pattern support for these domains has been dramatically improved to enable 
virtually any kind of formatting you wish.  Day of week is now possible for dates, 
and all separators are user-specified.  Numbers can now have decimal separator and 
thousands separator characters completely user specified, and currency symbol is 
both user specified and now can be set individually for different numbers if desired. 
Numbers can also have both leading and trailing positive and negatives symbols of 
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one or more characters each.  Automatic prefix and suffix properties can be added, 
and the am/pm notation for times is also user specified. New options for 
capitalization of month names are available, and ordinals (e.g. May 31st) can now be 
output automatically if desired. 
 
All edit pattern dialog boxes show the resulting edit pattern at the bottom of the 
window, so you can see what it will look like and how much space it will take in the 
design window.  The report object is displayed on the report design window using 
the edit pattern. 
 
Default edit patterns for dates, times, timestamps and numbers are set on the options 
window (see figure below).  These will be used by default whenever an edit pattern 
is required, and may be subsequently changed for the object. 
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Numeric Domain Edit Patterns 
Numeric edit patterns are specified using the dialog box below.  Set the integer 
positions and decimal positions as desired.   If you do not want rounding, leave the 
rounding position value at zero.  Round in the first decimal position by setting the 
rounding position to 1.  Round in the third integer position (to the nearest thousand) 
by setting the rounding position to -3, and so on.  
 
A prefix and suffix are optional.  Any text may be used, and it will automatically be 
added at the beginning or end of the resulting formatted output.   Suppress zero 
valued numbers by setting the ‘Suppress if Zero’ option.  Treatment of leading zeros 
in the integer portion of a number is specified using the drop down list box. Three 
options are available – suppress all leading zeros up to the decimal separator, 
suppress all except the first integer position, or do not suppress any leading zeros. 
 



 

 
 

 

22 • New Report Designer Report Composer Version 5.0 What's New 

 

 

 

 

 
 
The thousands separator is optional, and is specified here.  It can be different from 
one report object to another.  The decimal separator is also specified here.  If no 
decimal separator is desired, leave this field empty.  You can still have decimals 
even without outputting a decimal separator.   If you desire to output a number with 
no decimal places, you can output it with or without a decimal separator by including 
it here or leaving it empty. 
 
A percent sign can be automatically output if desired by setting the option here. 
Also, the fill character can be optionally used if desired.  The fill character will 
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automatically pad high order integer positions, replacing leading zeros.  The fill 
character itself cannot be changed from one field to the next – it is common to the 
report definition and is set in the report definition defaults. 
 
Numeric signs representing the positive or negative value of the number are 
completely customizable for each  numeric output field.   You can specify what 
character, or characters, to use for positive values and for negative values, and this 
can be specified as a leading character, trailing character, or both.  For example, to 
represent negative number in brackets such as (12.45), set the negative leading sign 
to “(“ and the negative trailing sign to “)”.  In addition, the signs can be either fixed 
or floating, with respect to leading zeros in the integer portion of the output.  
Numbers with a value of zero will display neither positive nor negative formatting. 
 
Since the edit pattern is actually displayed on the report design window, you have the 
option of specifying whether to use a negative or positive number as the sample on 
the design window. 
 
Numbers can be aligned automatically within their reserved output width, either left, 
right or decimal place aligned.   
 
Currency character formatting is optional, you specify the desired currency 
character, or characters,  here.  There is a default for the report definition, which in 
turn is taken from the workstation defaults, but it can be different for each report 
object if desired.  The currency character can be fixed or floating, leading or trailing, 
and inside or outside of the numeric sign characters.  You can also specify that it 
should only be output once per page for a particular report object. 
 

Date Domain Edit Patterns 
Date edit patterns are set using the dialog box below.  There are a number of 
predefined date format styles – you can select one from the drop down box.  The 
properties in the remainder of the dialog box are automatically set to match the 
selected predefined style. You can then alter some of the properties if the style is not 
exactly what you want. 
 
Begin by setting the order of the three parts of the date – the day, month and year.  
You can then set an optional text prefix, a suffix, and the two separators to be used 
between the first, second and third parts of the date.  The day of the week can also be 
added, either leading or trailing the entire other three parts of the date, and there is an 
optional separator for it.  Put a space in the separator to leave a space, or any other 
characters.  The day of the week can be the full day, or a three character 
abbreviation. 
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Each of the main three parts of the date (day, month and year) can be formatted in a 
variety of ways. Finally, alignment of left or right can be specified.  Alignment is 
necessary because the space reserved for the formatted date in the output is always 
reserved to the maximum size, taking into account differences in the length of 
different month names, for example.  So dates with shorter month names will occupy 
less space in the output – therefore you can have the result right or left justified. 
Centering within the date output is not supported. 
 

Time Domain Edit Patterns 
Time edit patterns are set using the dialog box below.  There are a number of 
predefined time format styles – you can select one from the drop down box.  The 
properties in the remainder of the dialog box are automatically set to match the 
selected predefined style. You can then alter some of the properties if the style is not 
exactly what you want. 
 
Set the format of each of the three parts of the time – hours, minutes and seconds.  If 
you do not want one of these parts to be output, you can set it to ‘none. You can also 
set the two separators that separate the three parts.  You can delete the separator and 
having nothing there if you do not wish it to appear in the output.  You will 
definitely want to do this if you omit one or two parts of the time output. 
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You can also set the edit pattern to use a 12 or 24 hour clock. This controls whether 
1:00 in the afternoon will be output as 1:00 or 13:00.  You can optionally use the am 
and pm notation, specifying it to be leading or trailing the rest of the formatted time 
components.  If you wish to use notation other than the letters ‘am’ and ‘pm’, you 
can customize these also.   
 
There is an option to control how midnight should appear – either as 24:00:00 or 
00:00:00.  And finally, the alignment can be left or right within the maximum sized 
output field.  Similar to dates, this is to control where the formatted time appears 
when allowing for smaller outputs when single digit formats for hours, minutes or 
seconds are used. 
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Timestamp Domain Edit Patterns 
Timestamp edit patterns are set using the dialog box below.  There are a number of 
predefined timestamp format styles – you can select one from the drop down box.  
The properties in the remainder of the dialog box are automatically set to match the 
selected predefined style. You can then alter some of the properties if the style is not 
exactly what you want. 

 

 
 
The timestamp edit pattern is the most complicated of all the domains, since it has so 
many components.  It is basically a combination of all the formatting options for 
times and dates, plus the additional microseconds.  You can select whether to have 
the date part or the time part first, but the microseconds are always last, or they can 
be omitted entirely. You can specify a prefix and suffix for the whole thing, as well 
as unique separators between the date, time and microseconds components. 
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New Graphical Design Objects For All Generated 
Programming Languages 

 
There are a variety of graphical report objects that can be added to reports in 
graphical mode.  These objects are ignored by the text only designer, and code is not 
generated for them when code is generated for the text only version of the report. 
 

 
 
 

Drawing Art 
You can add vertical lines, horizontal lines and boxes to the report design (see figure 
below). Left-mouse click the desired object on the candidate object tree, or insert it 
using the menu. The icon will change to a pencil shape.  Click and drag with the 
mouse to draw the object to the size desired.  Immediately after drawing the object, it 
will be selected.  You can then change its properties on the property sheet to set the 
color of the lines, the background color, the width of the line, and the line style. 
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Hyperlink 
Since you will be viewing graphical reports with a browser, it is also possible to add 
hyperlinks, such that when the report created at runtime is viewed in a browser, you 
can click on the image and jump to a specified location.  
 
There are two types of hyperlinks that can be added: images and literals.  The 
hyperlinks can be inserted directly, by dragging them from the candidate object tree 
or inserting them using the menu, or, you can insert a literal or image object, and add 
the hyperlink data afterwards using the property sheet. Literal hyperlinks change 
color and are underlined on the design window, differentiating them from regular 
literals. 
 
The hyperlink data can be set up in two ways – either by coding the location at 
design time into the Hyperlink property, or by assigning a text domain attribute as 
the source for the link location at execution time using the HyperlinkDatafield 
property. HyperlinkDatafield can only be set to text domain attributes in the import 
views of the EAB – if there are no text domain attributes, then this property cannot 
be used. 
 

Picture 
A picture, or image, can be added to the any section on the report. Left-mouse click 
the picture object on the candidate object tree, or insert it using the menu. The icon 
will change to a pencil shape.  Click and drag with the mouse to draw a rectangle 
indicating the size of the picture to be inserted.  This rectangle is a place-holder for 
the image.  Immediately after drawing the object, it will be selected.  You can then 
change its properties on the property sheet to select the desired image.  Select the 
DevelopmentFilePath property, and navigate to the desired image.  The image will 
automatically be adjusted to fit the size of the rectangular place-holder you drew 
previously.  At the same time, the ProductionFilePath property will also be set to 
match the DevelopmentFilePath property.  You can change it if you need the image 
to be sourced from a different location when the generated code is executed.  
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Further flexibility for the source of the image is provided by the FilePathDatafield 
property.  You can optionally set this equal to one of the text domain attributes from 
your EAB, and the image will be sourced from the location or path provided in the 
data in that text attribute at runtime.   This is very useful if your database has paths to 
images on disk or at some URL on the internet, and you want to use those in your 
report dynamically at execution time. 
 
Finally, any image can have hyperlink information added to it so that it will behave 
as an active link when the generated report is viewed in a browser.  See the section 
on hyperlinks above for further details. 
 

Table 
Table objects provide a sophisticated option for presenting data in a grid with rows 
and columns.  Insert a table by a left-click on the table object in the candidate object 
tree, or selecting it from the insert menu.  The mouse icon will change to a pencil 
shaped, enabling you to draw an initial size for the table. By default, a table with 
three rows and three columns is always drawn when a table is first inserted. 
 
You may then modify the table to the desired size and shape by clicking and 
dragging the lines between rows and columns. The mouse cursor will change shape 
when it hovers over the correct location. Right-click the mouse on the table to 
display a menu of additional table functions.  You can also modify the number of 
rows and columns on directly on the table property sheet. 
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From the pop-up menu, you can insert and delete rows and columns. You can also 
split a cell, or merge rows and columns to provide interesting tables like this one. 
The table borders can be set to a particular border color and width, and each can have 
its own background color. The objects placed in the cell will also have their own 
colors and display properties. 
 

 
 

Each cell can have one object inserted into it, including literals, attributes, special 
fields, pictures and so forth. 
 

Checkbox and Radio Button 
Since reports are not interactive in nature, the uses for checkbox and radio button 
objects are limited. However, they can make an attractive presentation option for 
printed report data, with their state set by the value of attributes in your EAB. To 
insert one of these objects, left-click with the mouse on the candidate object tree and 
drag it to the desired location, or insert it using the insert menu.   
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The default caption will be set to ‘Checkbox’ or ‘Radio Button’. After inserting it, 
you can change its properties on the property sheet.  You can change appearance 
properties to set the font, border color, background color, border style and width. 
You can also change the caption by setting the Caption property, changing the 
default value from ‘Checkbox’ or ‘Radio Button’.  If desired, the caption can 
actually be set dynamically, using the value of any text domain attribute in the EAB 
import views, by setting it with the CaptionDatafield property. 
 
The caption can be on the left or right, set this using the DisplayOnLeftFlag.  The 
StateFlag property is set to true or false, depending on whether you want the 
checkbox or radio button to show as selected or not.  But more likely, you will want 
this to be determined at execution time based on the value of an attribute.  To do this, 
set the property ValueDatafield to the attribute whose value will determine the 
setting of the checkbox/radio button.  Next, you must indicate what value for the 
attribute sets what state value.  Set the property UserValue to the desired value, and 
the property StateFlag to the state of the checkbox or radio button (true or false) that 
should be set when the attribute has that UserValue at execution time.   For example, 
if you want the checkbox to be checked when the attribute IMPORT.MYDATA.X = 
7, set ValueDatafield to IMPORT.MYDATA.X, UserValue to “7”, and StateFlag to 
True.  
 

Layering 
In graphical mode, objects are permitted to overlap one another.  Objects behind 
other objects may be completed or partially obscured.  To change the layering, right-
click the mouse on an object. A menu will be displayed enabling you to move the 
object to the front or to the back. 
 

 



 

 
 

 

32 • New Report Designer Report Composer Version 5.0 What's New 

 

 

 

 

 
NOTE: Objects in plain text mode may not overlap, and code generation for plain 
text only reports with overlaps will be prevented by a consistency check error. 
 

New Graphical Design Objects For Java Only 
 

Charts 
Chart objects are supported for Java environments only.  The candidate object tree 
will show the chart object (see figure below) if the EAB source language is Java, or 
if it has been created using the Gen plug-in feature.   If a chart is created in an EAB 
definition created from the plug-in, you will not be able to generate code to target 
languages other than Java – a consistency check error will occur. 
 

 
 

Charts of different types can be created, including pie, bar, line, area and many more.  
To insert a chart object into the report design, use the mouse to click the chart object 
on the candidate object tree.  Then move the mouse over the design window – the 
mouse icon will change to a pencil, and you can draw a rectangle to define the space 
where the chart will be.  A chart property dialog box will be presented (see figure 
below), with four tabs that will take you through the various properties for defining 
the chart. 
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There are numerous properties to be set depending on the type of chart.  Select the 
chart type on the first tab.   You can click the name from the tree on the left, or click 
the corresponding thumbnail sample of the desired chart on the right. Certain charts 
can be presented in either a vertical or horizontal mode – click the radio button 
below the chart type tree to see the alternatives. 
 
After selecting the chart type, click the Plot tab (see figure below), and make any 
desired changes to these properties. 
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Next, click the Series tab (see figure below),  and set the source of the data to be 
used for the chart.  Depending on the chart type, some charts have only one data 
source, while others have two. The X value reference and Y value reference drop 
down lists will allow you to choose the data sources from the attributes in your 
EAB’s import views. 
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Click the fourth tab, Others, to set the remaining properties for the chart (see figure 
below).  
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Finally, click the OK button to complete the specification of properties and the 
adding of the chart to the report design  A representative picture of a chart will be 
shown in the report designer.  It will not reflect the properties you specified for your 
report – those will only be rendered when the report is created at execution time.  
 
The report can be resized on the design window by dragging its borders with the 
mouse.  You can also change the reports properties by selecting Chart Properties on 
the chart objects property sheet, as shown below. 
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Formula Fields 
 
Formula fields enable you to create a formula to derive a value at execution time, 
based upon a formula you write in the designer.  Each formula field is defined with a 
length and one of the basic supported domains (text, numeric, date, time, timestamp). 
Formula field objects are supported for Java environments only.  The candidate 
object tree will show the formula field object (see figure below) if the EAB source 
language is Java, or if it has been created using the Gen plug-in feature.   If a formula 
field is created in an EAB definition created from the plug-in, you will not be able to 
generate code to target languages other than Java – a consistency check error will 
occur. 
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To create a new formula field, double-click the Formula Fields icon in the candidate 
object tree, or select the Create/Edit Formula menu item from the Edit menu, as 
shown below. 
 

 
 
The dialog box below will be displayed to allow you to define the formula name, its 
domain, and for numeric and text domains, the length of the formula results. The 
length of the field can be changed later from an icon on the formula editor toolbar. 
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When you OK this, you will be presented with the formula editor dialog box.  The 
formula editor provides a place for you to write the necessary script to derive the 
formula field value you need.   
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The editor window provides a data entry area at top, wherein the formula, simple or 
complex, can be written.  Below, you can see the list of data objects available to use 
in the formulas, a ‘keypad’ with common functions, and a list of functions supported 
in the scripting language.  
 
The formula must return a value consistant with the domain selected earlier when the 
formula was first created.  It may be many lines long, including comments.  The 
formula will be checked for correctness before allowing you to save changes.  In the 
example above, two numeric variables called ‘I’ and ‘n’ are created. Then N is set to 
a value of 9, and I is set to the square root of n using the sqrt function. Finally, the 
value of I, which will be 3, is returned as the value of the function.  This is all 
calculated at execution time. 
 
After the formula is created, is will be available on the candidate object tree (see 
figure below) as a new object available to be used anywhere on the report design.  
Simply drag it from the candidate object tree, the same way you would an attribute, 
and drop it where desired.  
 

 
 

When placing the formula, recall that it has a domain you defined for it when you 
created the new formula.  When placed on the report, this object will now have edit 
pattern support for that domain.  It will automatically be placed with the default edit 
pattern for that domain, which can then be changed in the usual way. 
 
If at any point you need to edit the formula itself, this can be done by double-clicking 
on the formula in the candidate object tree, to display the formula editor. Alternately, 
you can select the formula in the candidate object tree, and then use the Edit menu to 
select the Create/Edit Formula.  Changing the formula will not require changes to 
any placements of that formula on the report, unless you want to change the edit 
pattern for some reason.  You cannot change a formula’s domain after you create it.  
If you need to do this, you must create another new formula with the desired domain. 
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The formulas will be calculated at execution time, depending on where they are 
placed in the various sections of the report.  
 

New Graphical Object Properties 
 

When in graphical design mode, objects have a number of properties that can be set 
to define their appearance.  Some objects have all of these properties, while others 
may only have a subset of the properties.  The properties include foreground color, 
background color, font (which includes font, font style, size, effects and color), 
border color, border style, border width, line style, line width and overline. 
 
Most of these properties will display as set in the report designer. In some cases, the 
report designer cannot show them exactly as they will be in the finished report.  
Clicking the web report preview button on the toolbar, shown in the figure below, 
will show you the actual result that will occur at execution time. 
 

 
 
 

New Layout Tools 
 

Layout Grid 
When in graphical design mode, there is an optional grid that can be turned on or off. 
The grid is drawn on the design window within each section.  
 

 
 
The spacing of the points in the grid can be set in workstation defaults.  When the 
grid is turned on, you can also turn on or off the SnapToGrid property. When turned 
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on, objects moved on the design window will automatically snap to align with the 
grid points. 
 

 
 

 

Horizontal/Vertical Alignment 
New functions are available in the designer to help you align objects with one 
another. Simply select several objects, then use either the Format menu, or right-
click one of the selected objects to display a pop-up menu, and choose the Align 
option.  You can align the objects using left, center, right, top, middle or bottom. The 
last object selected will be used as the anchor point to which all the other objects will 
be aligned. 
 

Make Same Size 
New functions are available in the designer to help you make objects the same size.  
Select several objects, then use either the Format menu, or right-click one of the 
selected objects to display a pop-up menu, and choose the Make Same Size option. 
You can make them the same size in height, width or both. 
 
Note that this only applies where it makes sense. You cannot use it with attributes for 
example, since their size depends on their edit patterns.  You can use it with 
primarily with drawing art.  Images can also be used, but in order to keep proper 
aspect ratio for the image, it will only make the object the same size in one direction. 
 



 

 
 

 

Report Composer Version 5.0 What's New New Report Designer • 43 

 

 

 

 

Horizontal /Vertical Spacing 
New functions are available in the designer to help you with spacing objects.  Select 
several objects, then use either the Format menu, or right-click one of the selected 
objects to display a pop-up menu, and choose the Horizontal Spacing or Vertical 
Spacing option.  You can elect to make the spacing between the objects equal, or to 
increase or decrease it. The amounts will be determined automatically by Report 
Composer. 
 

Format Painter 
In graphical design mode, objects have many formatting properties such as color, 
font, border properties, and so on.  The format painter tool, located on the toolbar 
(see the icon that looks like a paintbrush in the figure below) or on the format menu, 
provides a convenient way to quickly set the format properties of a selected object to 
be the same as the format properties of some other object.  To use it, simply click the 
object whose format you want to copy, and then click the format painter tool.  The 
icon will change to a paintbrush, which you then move and click on the object to 
which the format should be copied.  
 

 

 
Automatic Prompt Generation 
When inserting attributes, you can set a new option that will automatically insert the 
attribute name (viewname.entityname.attributename) as a literal prompt for the 
attribute, then insert the attribute.  The prompt will be automatically inserted on the 
left of the attribute when attributes are placed individually.  This option can be 
turned on from a checkbox icon on the toolbar (see below), from the View menu, or 
from the PromptFlag property in the report definition properties sheet. 
 

 

 
Multiple Attribute Insert 
When more than one attribute is selected on the candidate object tree, they can all be 
dragged at once and placed onto the report design. The order in which they are 
placed on the design window corresponds to the order in which they were selected 
on the candidate object tree.  
 
Before dragging the selected attributes, right-click the mouse on one of them.  An 
option to insert them vertically or horizontally is presented.  Inserting vertically will 
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drop them onto the design moving down the section.  Inserting horizontally will drop 
them onto the design moving across the section. If automatic prompt generation is 
turned on, the prompts are also inserted appropriately.  When inserting vertically, 
prompts are automatically inserted to the left of the attribute.  When inserting 
horizontally, prompts are automatically inserted above each attribute as they are 
dropped horizontally across the page from left to right. 
 

Zoom In/Out 
The designer defaults to resolution at 100%, but you have the ability to zoom in 
closer, in amounts up to 400%.  This can be very helpful when fine alignment is 
required.  The zoom in and zoom out tools are located on the toolbar (see below), 
and also on the View menu.  
 

 
 

Insert Summaries 
Summary fields can be created in two ways.  You can place an attribute on the 
report, and then go to its properties and set the Usage property to Sum, Minimum, 
Maximum, Average or Count.  When the attribute is first inserted by dragging it 
from the candidate object tree, its Usage will be set to Display. 
 
Alternatively, you can select the desired attribute on the candidate object tree. Then, 
instead of dragging it onto the report design, use the Edit menu and select Insert 
Summary.  You will be able to insert the desired summary from the menu – when 
you click it, the mouse icon will change to an image of the attribute default edit 
pattern, which you can then drag and click to drop where desired. The objects Usage 
property will have been set to the desired type. 
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Object Placement Guides and Rulers 
To assist in placing objects exactly where desired, object placement guides and rulers 
are available. These can be turned on or off from View menu. The rulers can be 
turned on and off for each EAB report definition.  To change the ruler properties, 
access the report definition properties from the toolbar, or the top of the report 
explorer tree. The ruler properties are under the Appearance category.  You can turn 
them on or off, and also set the scale to centimeters, inches, pixels or twips. 
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The placement guides are shown only when a single object is being dragged on the 
design window. The guides show dotted lines extending to the horizontal and vertical 
rulers at the edge of the designer, and also color a blocked area on the ruler 
representing the exact height and width of the object.  This allows for precise 
placement of the object. 
 

 
 

Rubber Band object selection 
Multiple report objects can now be selected on the design window using the mouse. 
Simply left-click and drag the mouse in the design window, and a rubber band box 
will expand. Release the button to automatically select all objects that were totally 
enclosed in the box.   Report sections cannot be selected in this way.  You can see 
the dotted line rectangle representing the rubber band in the figure below. 
 

 
 
Alternately, multiple objects can be selected by holding down the CTRL key while 
clicking objects on the designer or attributes on the candidate object tree. 
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Other New Features 

AllFusion Gen & Plug-In Support 
 

Support for AllFusion Gen 7 and Advantage Gen 6 Plug-ins will be available in 
Report Composer 6. With this feature, the user will have  the choice to define new 
EAB definitions in Report Composer using the Gen plug-in feature instead of 
analyzing generated source code stubs is now supported.  This in turn enables Report 
Composer to achieve 100% accuracy for domain properties automatically and allow 
the cross generation of EAB's into different languages without the need to perform 
version control. 
In order to use the Plug-In feature, the user must have version 6.5 service pack 2 of 
Advantage Gen (or higher) installed and the AllFusion Gen model open on their 
desktop.  
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When creating a new EAB definition, select the ‘AllFusion Gen Plug-in” as the 
source instead of an EAB stub, and Report Composer will automatically interrogate 
the currently open Advantage Gen or AllFusion Gen model and provide a list of 
External Action Blocks to choose from.  It will then create an EAB definition from 
the selected EAB, eliminating the need to examine the stub source code generated by 
Gen. 
 
 

New Support For Crystal Reports 
 
Crystal Reports can now be more tightly integrated into Report Composer – this is 
one of several new Crystal licensing options.  Our CANAMCR132 runtime 
executable is no longer necessary and has been completely eliminated from the 
runtime architecture, resulting in one less object to manage for deployment, and 
improving overall runtime performance. As a result, the EAB generated for Crystal 
reports will be a C++ EAB rather than an ANSI C EAB. The user must compile the 
EAB using the appropriate methods. All other C-language Report Composer EAB’s 
will continue to be generated in ANSI C. 
 
Improvements in CANAMCR232 provide improved control of the runtime Crystal 
Report preview window and printing functions.  Crystal Reports version 10 is 
supported by Report Composer 6, and is optionally available for purchase directly 
from Canam Software. 
 
In addition, the .rpt file is now saved in the Report Composer repository. It is 
automatically unloaded from the repository when the EAB definition is opened, so 
that you can work on it with the Crystal Reports designer.  When the EAB definition 
is saved, it is also saved in the repository.  It will automatically be checked in and out 
from the shared repository as well, along with the rest of the EAB definition. 

 

Repository Manager and Development Coordination 
 

The workstation and shared repositories have both been simplified, reducing their 
internal table count from 12 tables to 2. The physical size of the repository will also 
be reduced . The smaller number of tables will significantly improve the speed of the 
save, load, checkin and checkout processes. Improvements have also been made to 
the checkin and checkout processes to reduce the chances of update failures and 
repository corruption. 
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The underlying database technology is upgraded to Jet 4, and support for binary 
objects allows us to save the Crystal .rpt files, images used on Canam Reports and 
certain Java files, directly in the repository.  You no longer need to manage these 
separately outside the Report Composer repositories.  The checkin and checkout 
functions include the coordination of these objects.   
 
A new read-only checkout option allows EAB definitions to be checked out to 
workstations where they can be viewed but not changed. This facilitates code-
generation-only capability as well, providing new options for development 
coordination. On the check-out window, there is a new option to select a read-only 
checkout.  In addition, an attempt to check-out an EAB definition already checked 
out will downgrade to a read-only check-out. 
 

 
 

 
 

Design Wizard Changes 
The design wizard has been restricted to use only for file handlers.  You can no 
longer use it to lay out reports. 
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